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1. Introduction
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LPCXpresso is a, low-cost development platform available from NXP. The software
consists of an enhanced, Eclipse-based IDE, a GNU C compiler, linker, libraries, and an
enhanced GDB debugger. The hardware consists of the LPCXpresso development board
which has an LPC-Link debug interface and an NXP LPC ARM-based microcontroller
target. LPCXpresso is an end-to-end solution enabling embedded engineers to develop
their applications from initial evaluation to final production.

The LPCXpresso IDE, powered by Code Red Technologies (http://I[pcxpresso.code-red-
tech.com), is based on the popular Eclipse development platform and includes several
LPC-specific enhancements. It is an industry-standard GNU tool-chain with an optimized
C library that gives engineers all the tools necessary to develop high-quality software
solutions quickly and cost-effectively. The C programming environment includes
professional-level features. There is syntax coloring, source formatting, function folding,
on- and offline help, and extensive project management automation.

The LPCXpresso target board, jointly developed by NXP, Code Red Technologies, and
Embedded Artists (http://www.embeddedartists.com/products/Ipcxpresso/), includes an
integrated JTAG debugger (LPC-Link), so there’s no need for a separate JTAG debug
probe. The target portion of the board can connect to expansion boards to provide a
greater variety of interfaces, and I/O devices. The on-board LPC-Link debugger provides
a high-speed USB to JTAG/SWD interface to the IDE and it can be connected to other
debug targets such as a customer prototype. Users can also use the LPCXpresso IDE
with the Red Probe JTAG adapter from Code Red Technologies.

Supported LPC products and board part numbers on the LPCXpresso platform:

e LPCB800: All part types supported
— OM13053: LPC812

e LPC1100: All part types supported

OM13014: LPC11U14

OM13012: LPC11C24

OM13035: LPC1115

OM13047: LPC1104

e LPC1200: All part types supported
— OM13008: LPC1227

e LPC1300: All part types supported
— OM13045: LPC1347

e LPC1700: All part types supported
— OM13000: LPC1769

e LPC1800: All part types supported

e |LPC2000: LPC2109, LPC2109/01, LPC2134, LPC2142, LPC2362, LPC2929

e |LPC3000: LPC3130, LPC3250

e LPC4000: All part types supported

All information provided in this document is subject to legal disclaimers. © NXP B.V. 2013. All rights reserved.
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LPCXpresso base board products:
e OM11083: Embedded Artists Base Board for LPCXpresso and mbed
e OM13009: Embedded Artists Motor Control Kit for LPCXpresso
e OM13016: NGX mbed-LPCXpresso baseboard

1.1 LPCXpresso 5 new features

e Support for Instruction Trace for Cortex-M3/M4 based MCUs implementing an
Embedded Trace Buffer (ETB)

e Support for Instruction trace for Cortex-M0+ based systems implementing a Micro
Trace Buffer (MTB)

e Based on Eclipse Juno and gcc 4.6.2
o New part support
For more information on LPCXpresso 5 new features visit:

http://support.code-red-tech.com/CodeRedWiki/NewInVersion5

PRESSO

l l

Eclipse-based IDE Development Beard
BT — (with LPC-Link)

-

1.2 LPCXpresso IDE

LPCXpresso’s IDE is a highly integrated software development environment for NXP’s
LPC Microcontrollers, which includes all the tools necessary to develop high quality
software solutions in a timely and cost effective fashion. LPCXpresso is based on Eclipse
with many LPC specific enhancements. It also features the latest version of the industry
standard GNU tool chain with a proprietary optimized C library providing professional
quality tools at low cost. The LPCXpresso IDE can build an executable of any size with
full code optimization and it supports a download limit of 128 kB after registration.
LPCXpresso supports the full embedded product design cycle by moving beyond chip
evaluation boards and supporting development on external target boards.

LPCXpresso_Getting_Started_Guide All information provided in this document is subject to legal disclaimers. © NXP B.V. 2013. All rights reserved.
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Fig 1. LPCXpresso IDE

1.3 LPCXpresso development board

LPC-Link Target

Fig 2. LPCXpresso development board
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1.4 LPC-LINK JTAG/SWD debugger

1.5

1.6
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The LPCXpresso board contains a JTAG/SWD debugger called the “LPC-Link” and a
target MCU. LPC-Link is equipped with a 10-pin JTAG header (highlighted on the above
image) and it seamlessly connects to the target via USB (the USB interface and other
debug features are provided by NXP’'s ARM9 based LPC3154 MCU). Cutting the tracks
between the LPC-link and the target will make the LPC-Link a stand-alone JTAG
debugger. This enables the LPCXpresso platform to be connected to an external target
and used to develop for a wide variety of NXP’s Cortex-MO0, Cortex-M3, and ARM7/9
based applications. Currently supported microcontroller products include LPC800,
LPC1100, LPC1200, LPC1300, LPC1700, LPC1800, LPC4000, LPC4300 series and
specific members of the LPC2000 and LPC3000 families.

Integrated evaluation target

The target includes a small prototyping area and easily accessible connections for
expansion. The LPCXpresso board with target can be used

¢ On its own for software development and benchmarking
e Connected to an off-the-shelf baseboard for rapid proof-of-concepts
e Connected to customer-designed board for a full prototype

LPCXpresso partners

NXP has partnered with Code Red Technologies and Embedded Artists for the
LPCXpresso platform. For added flexibility and higher memory configurations, the
LPCXpresso platform can easily be upgraded to include full-blown suites from Code Red
Technologies and more advanced hardware kits from Embedded Artists. Please visit the
LPCXpresso webpage for more information.

ﬁcode_red @Em%‘i‘}}‘ﬁﬂ
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2. Evaluate, explore and develop

Imbrdded
Arimfy

Base board

Any Custom Board with
a JTAG Connector

Fig 3. Product development stages

Users can envisage three stages from evaluation to product development. During
evaluation, features and peripherals of the target MCU can be easily tested with the
prototyping area and easily accessible connections on the target board. Complementing
the target board are also easy-to-use example projects and a handy Getting Started
guide. For rapid proof-of-concepts, users can get an off-the-shelf base board from
Embedded Artists and quickly explore the next level of applications. And finally
LPCXpresso users can seamlessly develop their final application by using the LPC-Link’s
10-pin JTAG connector to attach any JTAG-capable custom board. This way, users can
now enjoy the same user experience right from evaluation to product development.

All information provided in this document is subject to legal disclaimers. © NXP B.V. 2013. All rights reserved.
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3.1 System requirements

3.2

LPCXpresso_Getting_Started_Guide

Operating System

Microsoft® Windows - XP 32-bit (SP2 or greater)
Microsoft® Windows - Vista 32-bit or 64-bit
Microsoft® Windows - Windows 7 32-bit or 64-bit

Microsoft® Windows — Windows 8
Mac OS X 10.7.5 (Lion), and 10.8.2 (Mountain Lion)
Linux - Ubuntu 9 trough 12Linux - Fedora 14 and 17

System RAM 2 GB MB minimum (4 GB recommended)
Hard Disk 500+ MB of available space.
Screen/Display Adaptor 1024x768 minimum recommended

Internet Connection

High-speed internet is recommended to download and register
the software

Note: LPCXpresso may install and run on other Linux distributions. However, only the
distributions listed above have been tested. Desktop virtualization tools supporting a
Linux or Windows guest with USB support can be used to run LPCXpresso on other

computing platforms.

Installation process
LPCXpresso is installed into a single directory, of your choice. Multiple versions can be

installed simultaneously without any issues. The installation process is to double-click the

installer file after downloading. Then click “next” on the setup wizard. To install under
Linux, the downloaded file should be marked as executable first using chmod +x.

Fig 4. Setup wizard

s
“ Setup - LPCXpressa ==
} r
. Welcome to the LPCXpresso
Setup Wizard
This will install LPCXpresso 5. 1.0 [Build 2048] an your
computer.
. Itis recommended that you dose all ather applications before
PR E SSO continuing.
Click Next to continue, or Cancel to exit Setup.
powered by
Mcode_red |
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Fig 5.

Setup wizard

. Setup - LPCXpresso =0

License Agreement
Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

CODE RED TECHNOLOGIES, LIMITED

End User Licence Agreement for LPCXpresso Software Development
Tools
October 2012

THIS END USER LICENCE AGREEMENT ("LICENCE") IS A LEGAL
AGREEMENT BETWEEN YOU (EITHER A SINGLE INDIVIDUAL, OR.

STNGIF TFGAT ENTITY) AND CODE RED TECHNOLOGIES TIMITFD 7
() I accept the agreement

.
@) I do not accept the agreement

PRESSD|

Read the license agreement then click next. There are a number of other screens on the
setup wizard, but generally the default options can be accepted. After the install, an
information file will be displayed. Click “Next.” Congratulations! Your LPCXpresso
installation is complete!

Fig 6.

Setup wizard

o

~
. Setup - LPCXpresso — L

Installing
Please wait while Setup installs LPCXpresso on your computer.

Extracting files...
C:\nxpLPC¥presso_5. 1.0_20482\Drivers\LPC-Link\x86\WdfColnstallero1009.dll

PRESSD

hittp: {fwww.nxp. com/pcxpresso
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3.3 Activation

To activate your product from LPCXpresso, choose Help->Product activation->Create
serial number and Activate. Once the wizard is open, click “Copy to clipboard” to copy
the LPCXpresso serial number into the clipboard. This serial number is based on your
machine’s hardware and operating system configuration, but contains no personally
identifiable information. Now click the button to open the registration activation page. This
should display a web form. After completing the form, you will receive an activation code
via email within a few minutes. Highlight the activation code in your email program, and
select Copy to place it into the Windows clipboard. Now, choose Help->Product
activation->Enter Activation code from within LPCXpresso. Paste the product
activation code into the Product activation dialog by right clicking in the Activation code
field and choosing “Paste.” Then click the “OK” button. You should receive a dialog
confirming acceptance of the activation code. It is also possible to complete LPCXpresso
activation on a PC that is offline as long as another PC has access to the Internet. Refer
to Fig 7 for the process.

LY L
Online PC |=|= Offline PC
1. Register and download IIII
LPCXpresso from www code-red- [ H |
tech.com/Ipcxpresso. Illl
2. Transfer the LPCXpr installer
to th: osfﬂ?ne PC. Crpressoinetsle Illl 3. Install LPCXpresso
IIII 4. Select "Create Serial Number and
l l Activate” from the Help menu. Write
4. Browse to |poxpresso.code-red- IIII down serial number and click "0OK."
tech.com/LPCXpresso/serialnumber, l .
log in, and enter the LPCXpressa I I
serial number from step 3. IIII
5. Once the activation code is l l 6. Select “Enter Activation Code"
received by email, write it down. IIII from the Help, Product Activation
llll menu and type in the activation code
I I from step 5 and click "OK."
il
Fig 7. LPCXpresso activation with offline PC
LPCXpresso_Getting_Started_Guide All information provided in this document is subject to legal disclaimers. © NXP B.V. 2013. All rights reserved.
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4. Getting familiar with the LPCXpresso IDE

4.1

LPCXpresso IDE is based on the Eclipse IDE framework and many of the core features
are described well in generic Eclipse documentation and in the help files found in the
help menu of the product. Further documentation and pointers to useful documents are
also available on the Code Red Technologies Wiki at http://support.code-red-
tech.com/CodeRedWiki.

Layout of the LPCXpresso desktop

LPCXpresso’s Desktop contains many windows. Each window is called a View, because
it displays a particular view of data in the LPCXpresso environment. This data could be
source code, hex dumps, disassembly, memory contents, or more. Views can be
opened, moved, docked, and closed, and the layout of the currently displayed Views can
be saved and restored. A specific configuration of Views is called a ‘Perspective.’
Typically, LPCXpresso operates in a single perspective under which both the code
development & debug sessions operate as shown on the next page. The single
perspective greatly simplifies the Eclipse environment and enhances the entire
LPCXpresso experience.

All Views in the Perspective can be moved around by dragging and dropping. If a View is
accidentally closed, it can be restored by selecting it from the Show View dialog. The
Show View dialog can be opened from the Show View Other... option in the Window
menu.

Window | Help

Fig 8. Show view/other menu

MNew Window

Mew Editor

Open Perspective 3

Show View v | ‘= Include Browser

Mavigation y | 1 Project Explorer

Preferences Other.. [}3 Alt+5hift+Q, Q
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4.1.1 Single perspective (code development)

Fig 9.
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1. Project Explorer View: The ‘Project Explorer’ gives you a view of all the projects in

your current ‘Workspace’. A ‘Workspace’ is a collection of projects that are stored in
a single Workspace Directory on your computer.

2. Editor: On the upper right is the editor which allows modification and saving of source

code as well as setting breakpoints in debug mode.

3. Console and Problems Views: On the lower right are the Console and Problems

Views. The Console View displays status information on compiling and debugging,
as well as program output. The Problem View (available by changing tabs) shows all
compiler errors and will navigate the Editor View to the error location.

4. Quick Start View: Below, the ‘Quick Start’ view has fast links to commonly used

features. This is the best place to go to find options such as Build, Debug, and
Import.
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1.2 Single perspective (debug)
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| Develop - Blinky/sre/main.c - LPCKpressa
File Edit Source Refactor Mavigate Search Project Run Window Help
s [ R~ e o BB et W e S OB Paaid Eimmig g | =] = O e®
I' 5 AR e R A Quick Access || B | [3X Develop
100 Registers §2 = B %5 Debug X [+ " =8
o E|| e a Blinky Debug [C/C++ MCU Application (DSF)]
Name Value Description - 4 i} Blinky.ad 2
58 Goncral Regict Goneral B 4 of® Thread [1] <main> (Suspended : Breskpoint)
4 3 General Registe eneral Purpose an.. e e
e 0:00000400 L 5 adb
e 000000001 I v
e 0:00000400 . B
e 0xE000EL00 [g) main.c 5 =]
e 0:000000D4 /* Set port p@.16 to output */ -
e s 0x000000D4 6PIOSetDir( €, 16, 1 );
e 0:12345678
b e 0x10000FDS /* Set port p8.17 to output */
i e OWFFFFFFFF GPIOSSEDAr( @, 17, 1);
] OxFFFFFFFF il init_nrt(oxB008); fl
W a0 i
Name = r@ k while (1) /* Loop forever */
Hex : 8xeee00488
Decimal:1024 ‘E /* 1/0 configuration and LED setting pending. */
Octal:B0006602000 L if ( (mrt_counter > @) & (mrt_counter <= 200) )
Binary: 1 |
Default:0x0aa00400 =2 GPIOSetBitvalue( 8, 7, @ ); |
« B
}
If ( (mrt_counter > 208) 82 (mrt_counter <= 480) ) t
& bpr. ¥ = B
_ - GPIOSetBitvalue( @, 7, 1 ); £ i
5B+ % R|6| A }
Expression Type, Value Mame : mrt_counr if ( (mrt_counter > 48) 82 (mrt_counter <= 668) )
Details:@
i 9= mrt_counter uin2t 0 Default:e GPTOSetBitvalue( @, 16, @ );
4 Add new expression Decimal:e
Heox: 8x8 if ( (mrt_counter > 5@8) 3% (mrt_counter <= 568) )
Binary:@
octal:e GPIOSetBitValue( @, 16, 1 );
- C o mm— g T IV ) .
I 5
E Console (5 Problems [ Memory | €5 Instruction Trace 57 |1 Red TracePreview (@) ¢ (@ G| B =z @33 & “ = 0
PC Disassembly  Info function filename
o . v« am v I
! | NXP LPC812 (Blinky)
Fig 10. Single perspective (debug)

Core Register View: This shows all of the registers in the processor core. Registers
that have changed from step to step are highlighted in yellow.

. Debug View: This shows you the stack trace. In the ‘stopped’ state, you can click on
any particular function and inspect its local variables in the Variables tab (parallel to
the Registers View). Debug controls can be found on the global toolbar (at the top of
the screen).

Editor: In here you will see the code you are executing and can step from line to line.
By pressing the ‘i’ icon at the top of the Debug view, you can switch to stepping by
assembly instruction. Clicking in the left margin will set and delete breakpoints.

Console View: On the lower right is the Console View. The Console View displays
status information on compiling and debugging, as well as program output.

Quick Start View: Below, the ‘Quick Start’ view has fast links to commonly used
features.
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4.1.2.1 Peripheral views

LPCXpresso includes full, annotated and interactive debug views of all the peripherals.
Access to the views is found on the Peripherals View (click the Peripherals tab) behind
the Project Explorer view. Each peripheral can be selected, and it is displayed in the
‘Memory’ view which is located behind the ‘Console’ view at the bottom of the

LPCXpresso_Getting_Started_Guide

LPCXpresso desktop.

oject Explorer |3, Peripherals+ 13 i Registers = B8
#E Y
Peripheral Address Description 5l
[} ?& CMP 040024000 Analog comparator
[C]'%, CRC 0x50000000 Cyclic Redundancy Check (.
= ?& DCR Oxe000edf0 Debug Core Registers (vGM) =
[C]'%, FLASHCTRL  0x40040000 Flash controller
= ?& GPIO-PORT  0xal000000 General Purpose /O port (...
% ¢ 0x40050000 12C-bus interface
[[]%, I0CON 0x40044000 1O configuration (IOCON)
2, MRT 040004000 Multi-Rate Timer (MRT)
[C]%, NvIC 0xe000e000 MNVIC Control/Status Regist..
[C]1'%, PIN-INT 0xa0004000 Pin interrupt and pattern ...
[C]1%, PMU 040020000 Power Management Unit (...
M5, scT

050004000
1

«|

State Caniuurab\eTin’ller 5.7
v

MRT [0:40004000] (Enabled)

Multi-Rate Timer (MRT)

Fig 11. Display of peripheral view showing selection of MRT peripheral

& Consele [, Problems | [J Memury 5 | @ Instruction Traze |8 Red Trace Preview

r ot ) B - T =0

Menitors - N B * ]
% MRT Registes Address Value |
a T MRt DDA 4 |
1 INTVALD 040004000 [ =
Wit VAL 0004010 %) |
MY INTVAL2 el0004020 [
i INTVALS UI0004030 L]
1 TIMERD 40004008 THE
4t TIMERL 0004012 T
Wi TIMERZ 0004024

DTHEFE =

Fig 12. Display of memory view showing detail of MRT peripheral registers
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4.2 Connecting the target

To begin development, the LPCXpresso can be connected to a PC using a USB 2.0
A/Mini-B cable.

Fig 13. USB 2.0 A/ Mini-B cable

If you are debugging a prototype board or a target containing a different MCU, see the
Appendix for a pin-out to connect the debugger section of the LPCXpresso to an external
target.
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5. Working with example projects

LPCXpresso_Getting_Started_Guide

5.1 Downloading NXP sample code from the web

) Quic.. 52 |69=Varia.. 9 Brea.. oF Outli. &7 Expr.. = 0

C0 Start here -
1z} New project...

g Build all projects [Debug]
‘s Build 'Blinky" [Debug]
& Clean 'Blinky' [Debug]
%5 Debug 'Blinky’ [Debug]

1

(2 Quick Settings =

52 Project and File wizards

<«

t £ Import and Export ¥ 1_

52 Build and Settings

L -

Fig 14. Quickstart panel

The LPCXpresso IDE includes several sample code bundles for various development
boards. To work with these projects, select “Import project(s)” from the Quickstart panel

in the lower left corner of the screen.

F

"~ Import project(s) V- — [ ———

=)

Import project(s)

Select the examples archive file to import.

@_

-

Projects are contained within archives (.zip) or are unpacked within a directory, Select your
project archive or root directery and press <Mext>. On the next page, select those projects you
wish te import, and press <Finish>,

Project archive (zig)

Archive

Project directory (unpacked)

Reoot directory

Browse for more examples

Press "Browse for more examples...” to view the latest examples and download to your local drive.,
Then use press "Browse..." (above) to import into your workspace,

P —

Browse...

Browse for more examples... ]

@ < Back MNext =

Fig 15. Import project(s) dialog
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Next, select “Browse” from the “Project archive (zip)” section of the Import project(s)

dialog.

The sample code bundles are located in the directory where the LPCXpresso IDE was
installed, under \pcxpresso\Examples\NXP. Navigate to the sample code bundle that

applies to your Target Device and select it.

%L Import project(s) - -

=)

Import project(s)

Select the examples archive file to impert.

Projects are contained within archives (.zip) or are unpacked within a directory. Select your
project archive or root directory and press <Next>. On the next page, select those projects you
wish to import, and press < Finishz.

Project archive (zip)
Archive Chnxp\LPCXpresso_51.0_2048\Ipoxpresse’\Examples\NXPALP CBO0\MXP_LP CBxx_SampleCodeBundle.zip

Project directory (unpacked)

Root directory

Browse for more examples

Then use press "Browse..." (above) to import into your workspace.

@:I < Back MNext = Finish

Press "Browse for more examples..." to view the latest examples and download to your local drive.
Browse for more examples...

Browse...

Cancel

Fig 16. Zip file from LPCXpresso-Support web site selected for importing

Now click the Next button and then choose which projects to import from the .zip file.
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R =)

Import project(s) .
Select a directory to search for existing Eclipse projects. /4
Projects:

Blinky (Blinky) - Select All

BOD (BOD)

CMSIS_CORE_LPCixx (CMSIS_CORE_LPCBsox) |
CMSIS_DSPLIB_CMO (CMSIS_DSPLIB_ChMO)
comparator (comparator) —

CRC (CRC) i
gpie (gpic)

2C @20

Ipc800_driver_lib (IpcB00_driver_lib)

LPCB12_5CT 4ch_pwm (LPC&12_5CT_4ch_pwm)
LPCB12_Sct_Blinky (LPCEL12_Sct_Blinky)
LPCBL12_5CT_pwm_decode (LPCE12_SCT_pwm_decode)
LPCEL12 SCT_um_pwm (LPCE12 SCT_um_pwm) i
PMU (PRALY

m

I [/] Copy projects into workspace

@ <Back | mes> || Fnish || Caneal I

Fig 17. Import projects(s): Selecting which projects to import

Often, there will be references between projects in a .zip file so it is best to import all of
them.

(T

Import project(s) .
Select a directory to search for existing Eclipse projects.

A

Projects:

Blinky (Blinky) 2|[ selectan |
BOD (BOD) : |
CMSIS_CORE_LPCiox (CMSIS_CORE_LPCBicd) [ Deselectal |

[@] CMSIS_DSPLIB_CMO (CMSIS_DSPLIB_CMO) ‘m|
omparator (comparator) —
RC (CRC)

gpio (gpio)

RC [12C)

IpcB00_driver_lib (IpcB00_driver_lil)
LPCB12_SCT_dch_pwm (LPCB12_SCT_dch_pwrm)
LPCB12 Sct_Blinky (LPCB12_Sct_Blinky)

LPC812 SCT_pwm_decode (LPC812_SCT_pwm_decode)
LPC812_SCT_um_pwm (LPC812_SCT_um_pwm) |
PMU (PMU)

m

=

I [/] Copy projects into workspace

Importing: /lib/libCMSIS_DSPLIE_CMO.a f
| ()

@ <Back || New> |[ Emsh  |[ cConca | [

Fig 18. Import projects: Progress indicator

e Updates to the example code bundles can be found at http://LPCWare.com between
releases of the LPCXpresso IDE.

LPCXpresso_Getting_Started_Guide All information provided in this document is subject to legal disclaimers. © NXP B.V. 2013. All rights reserved.

User guide Rev. 12 — 17 April 2013 18 of 49




NXP Semiconductors LPCXpresso

Getting started with NXP LPCXpresso

5.2 Debugging/running ‘blinky’ or another project on your LPCXpresso
board

In LPCXpresso, when you start to debug, your program will automatically download to
the target and be programmed into flash memory.

To start debugging on your target, simply highlight the project in the Project Explorer and
then in the Quickstart Panel select ‘Debug ‘Projectname’ [Debug].

M Q.. 2 0=V.. 9B 0. 6FE. = O

»

= Start here
] New project...

® Import project(s)

»

oy Build all projects [Debug]
4, Build 'Blinky' [Debug]

& Clean 'Blinky' [Debug]
¢ %5 Debug 'Blinky’ [Debug] R

(2 Quick Settings v

m

“. Project and File wizards

£

L SRS S w

Fig 19. Debug

You may also enter debug mode by clicking the bug icon on the top LPCXpresso toolbar.

RSB M S e sG 0%

Fig 20. Bugicon

You are then presented with the debug view and toolbar and have run control over the
code running on your target. The debug toolbar will pop up above the code window.

S EBOEEEA TSR P -0 A eF B e ToS® o

Quick Access B | & Develop

ﬁ%Debug s % &1 | == ¥ = 8

4 1 Blinky.axf -

a4 g Thread [1] <main> (Suspended: Breakpoint) |;|

= main() at main.c:48 0:306 =

wl gdb %

Fig 21. Debug toolbar
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You can now do the following with the buttons towards the top of the ‘Debug’ view:

= |[Run the program.

Step Over C/C++ line.

Step into a function.

m [Stop the debugger.

Pause Execution of the running program.

£ Restart the debug session

Fig 22. Debug buttons

5.3 Working with Instruction Trace

Instruction trace provides the ability to record and review the sequence of instructions
executed on a target. LPCXpresso 5 introduces support for instruction trace via on board
trace buffers. Instruction trace makes use of the Embedded Trace Buffer (ETB) on
Cortex M3 and M4 parts and the Micro Trace Buffer (MTB) on the Cortex-M0O+. The
instruction trace which is generated at high speed can be captured in real time and
stored in these on-chip buffers, so that they can be downloaded at lower speeds without
the need for additional debug hardware.

For information on how to configure LPCXpresso 5 to work with Instruction Trace, please
refer to the “Getting Started with Red Trace guide” that is available for download from the
Code Red support website:

http://support.code-red-tech.com/CodeRedWiki/NewInVersion5

Please note that only the Instruction Trace part of the guide is applicable to the
LPCXpresso-IDE.

6. LPCXpresso IDE tips and tricks

6.1

6.2
6.2.1

LPCXpresso_Getting_Started_Guide

User guide

Installing Eclipse plugins

The LPCXpresso IDE contains many of the features of the Eclipse open-source IDE from
http://www.eclipse.org. The browse and install plugin function is present in the help
menu. To access it, choose Help -> Install New Software. This will display the Eclipse
Install Software dialog which will allow browsing and installing of Eclipse plugins.

Debugging tips
Debug features not enabled

All of the LPCXpresso features are context-sensitive. If features are disabled, double-
check that you are navigated into a .c file in an open project on the Project Explorer
View, or some menu items and toolbar buttons may be disabled. If your workspace

All information provided in this document is subject to legal disclaimers. © NXP B.V. 2013. All rights reserved.
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contains projects that create libraries such as CMSIS, please note that debug features
will be disabled if you are currently editing a .c file that is part of a library project.

6.2.2 Error launching debug\filename.axf

5 foror repurted by target T )

| GOy Target seported sroes. |
|
 Resson:
03 Fatled on chip setup
- |

| 03: Failed on chip setup
Eervbed, misrratched, or sl koo past

Fig 23. Error starting debug

LPCXpresso checks the target chip ID against the currently selected chip ID for the
project and will not start if there is not a match. Make sure that the correct NXP LPC
microcontroller part is selected in LPCXpresso. The current part number is displayed in
the status bar at the bottom of the LPCXpresso window. It can be changed by holding
down the Ctrl key and clicking. A dialog will appear allowing selection of the correct part
number.

: NXP LPC812 (Blinky)

Praoject: Blinky
MCU Vendor: NXP

MCU Mame: LPCE12

Workspace: Ch\Users\nxp51705\Desktophdelete me
(Clicks Browse, Ctrl-Click: Terminal window)

Fig 24. Current part number
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“_ Properties for Blinky = |
o pe fites text] MCU settings T T
Resource
Builders ot
4 C/C++ Build NXP LPCE12 N
Build Variables . LPC3m (L2bit ADC)
[J.s:.mreryoptmf'S LPC1700
Environment LPC177x 8¢
Logging LPCl850¢
MCU settings

» LPC2000

» LPC2900

LPC3000
LPC407x_8x

» LPCa3xx

4 LPCBix
LPCE10
LPC811
LPC812

Settings
Tool Chain Editor
C/C++ General
Project References
Run/Debug Settings

Target architecture: cortex-m0

Memary details (LPCE12)
Flash driver:

Memory Type | Name Location Size
Flash MFlashl6 00 04000
RAM RemLocé 0:0000000  0:1000

Edit...
Restore Defaults Apply

Fig 25. Selecting correct part number

6.2.3 Optimization issues

When optimization is enabled, it will reorder code. What this means is that the code from
multiple C lines will be intermingled. In addition, assignments and initializations might be
pulled out of loops so they are only executed once. Changes like these will make the
code confusing to debug. Some symptoms you might see are breakpoints that only work
the first time through, or seeing the debugger’s current line indicator fail to advance or
even move backwards when you click step. It is best to always use —O0 for debugging.
Since optimization can make such a big difference in code size and performance, it is a
good idea to test your project with optimization and plan for a final build that is optimized.

6.2.4 Exiting debug mode and stopping debugging

To stop debug press the ‘Stop’ button (red square) shown in the toolbar at the top of the
debug view.

6.2.5 Recovery of board

After playing around with the LPCXpresso board, especially when trying out new PLL
settings, reconfiguring the SWDIO/SWDCLK pin functions, disabling AHBCLKCTRL bits,
or trying power down modes, the board may be disabled and no longer enter debug
mode. This is caused by code on the on-board flash that incorrectly disables the system
clocks or the debug port soon after reset before the debugger can connect to the core.
The easiest solution to this is to load a working project into LPCXpresso, ground the ISP
pin (see the chip User’'s Manual for details) and then try to enter debug mode.

Grounding the ISP pin during reset will put the target MCU into In-System Programming
(ISP) mode. It will wait for a command through the serial port or the USB port. This
temporarily prevents the troublesome code in flash from starting. Although ISP is
designed to enable serial and USB updates, while ISP is running, the LPCXpresso
toolchain is able to connect to the Cortex core and reprogram the flash. After the flash is
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reprogrammed, disconnect the ISP pin (pull it high or allow it to float) and stop
debugging. Now you should be able to debug code again.

6.3 Datasheet browser

The LPCXpresso IDE comes with an integrated web browser that will direct viewers to
the datasheet of the device. Just click on the part number in the lower right border of the
LPCXpresso window to see the browser in action.

[£] Ipedix_gpio.c [ main.c (@ Welcome @ Technical support portal :: NXP Semiconductors &3 = 0
=] ] oéb http://www.nxp.com/technical-support-portal/#/tid=50809,5id=71790,bt= tab=datasheets p=1,rpp=,sc= so= * B
-
¥} 5] User i Literature {3) Show all (5)
Documents

m,

Viewing 1to 10f 1 rows [25rows [«]

File Name e Title e Type e Format = Date ¥
dL LPC81XM 32-bit ARM Cortex-k0+ microcontroller; up to 16 kB flash and 4 kB SRAM Data sheet pdf 2013-01-28
RE8S

L NI S SR L R L A

Fig 26. Integrated web browser

6.4 Code size
6.4.1 printf

When optimizing a project for size, if you are using printf, make sure that Redlib is
selected as the standard library in the Projects Properties dialog. This option can be set
using the Quick Settings dropdown box in the Quick Start panel.

) Quickstart Panel 57 69= Variables 9 Breakpoints 5T Outline & Expressions = 08
@ New project...

* Import project(s)

oip Build all projects [Debug]
&, Build ‘Blinky’ [Debug]
& Clean 'Blinky' [Debug]
% Debug 'Blinky' [Debug]

@ Quick Settings =

m

# Set library type » Redlib (none) 4
i Defined symbols [Blinky Debug] Redlib (nohost) -
i Undefined symbols [Blinky Debug] Redlib (semihost) ke
23 Include paths [Blinky Debug] MNewlib (none) o
8 Library search paths [Blinky Debug] Mewlib (nohost) ¥
B8 Libraries [Blinky Debug] Mewlib (semihost)

<«

Fig 27. Reconfigure library setting

The printf implementation in Redlib is about half the size of the implementation in Newlib.
A smaller printf library can be used in Redlib if floating point formatting strings are not
used. To select this smaller library, define the symbol CR_INTEGER_PRINTF to the
compiler (i.e. -DCR_INTEGER_PRINTF). To save even more space, avoid using printf or

LPCXpresso_Getting_Started_Guide All information provided in this document is subject to legal disclaimers. © NXP B.V. 2013. All rights reserved.

User guide Rev. 12 — 17 April 2013 23 of 49



NXP Semiconductors LPCXpresso

6.4.2

6.5

Getting started with NXP LPCXpresso

any C standard library functions and select Redlib (none). Depending on your printf
settings and code, this could free up 10K to 20K of flash memory.

Optimization

Optimization can do a lot to save flash memory. It can be configured in the same dialog
as the C standard library. Choose “Optimization” under “MCU C Compiler” in the “Tool
Settings” tab. Higher levels of optimization will typically result in higher performance, but
may result in larger code size. It is best to use —OO0 for debugging and higher levels for
Release. For best code size try —Os —mword-relocations. To further reduce code, add
--gc-sections to the project linker flags. This causes the linker to remove unused
functions from the compiled code. --gc-sections is enabled by default in new projects
created by the project wizard. If you are working with an existing project, you may need
to manually add this option to your project. --gc-sections is safe to use in both Release
and Debug builds. There are many optimization options available for GCC. Visit
http://gcc.gnu.org/onlinedocs/gcc/Optimize-Options.html to see all of them.

Showing hidden views

A view is an on-screen representation of something in the IDE. A view can be source
code, the project tree, or a debug window. If you accidentally close a view, you can open
it again by going to the Window menu and choosing Show View and Other. It is a good
idea to browse through the Show View window to see what is available.

% Show View l E] |

type filter text

- = General »
w2 C/C++
» = CVS
4 (= Debug
®g Breakpoints
:f} Debug

m

(2 Executables

& Expressions

@ Memory

@ Memory Browser
=i, Modules

5 Peripherals+

B Red Trace Preview

18l Registers o

h

Fig 28. Show view window

This will present a dialog allowing you to pick a view and display it.

6.6 Creating a ‘skeleton’ project in a new Workspace

LPCXpresso_Getting_Started_Guide

User guide

LPCXpresso includes several project Templates to help get started quickly.
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6.6.1 Create a new Workspace

From the ‘File’ menu hover over ‘Switch Workspace’ and then select ‘Other..." from the
bottom of the list. You will then see the ‘Workspace Launcher’ dialog shown below.

Enter or browse to the new path for your workspace. We have called our new workspace
‘NewWorkspace’.

r

- Workspace Launcher @

Select a workspace

LPCXpresso stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace:  Chnxp\MewWorkspace - Browse...

» Copy Settings

@:‘ QK l ’ Cancel

S

Fig 29. Workspace launcher

Then click on OK to re-open LPCXpresso with this new workspace selected.
6.6.2 Create the ‘Skeleton’ project

o If you are using a Cortex-based part, first, import the CMSIS header files for the chip
family you are planning to work with. To do this, click “Import Project” and navigate to
the CMSIS<version/part>.zip. The CMSIS header files are installed with LPCXpresso
in C:\nxp\Ipcxpresso\lpcxpresso\examples\nxp. Once this project is added to your
workspace, click “Build all projects (Debug)” in the Quickstart Panel.

o Click on ‘New project...” and select the NXP C project type for your architecture.

e Click “Next” and enter a project name. In this case we will use ‘MyProject’ then click
‘Next.’
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[

New project...
LPC80¢ -» C Project

Project name: | MyProject

Use default location

Location: | Chnxp\NewWorkspace\MyProject

Browse...

| Finish

Cancel

Fig 30. Enter project name

e The next section of the dialog will ask you to specify which chip in the family you are

using.

L

MNew project...

Select the target MCU

Target selection

NXP LPC812
LPC13mx
LPC13wx (12bit ADC)
LPC1700
LPC177x_8x
LPC18:0c
LPC2000
LPC2900
LPC3000
LPCA0Tx_8x
LPC43mx
LPCaux
LPCE10
LPCELL

-

[ S

m

( LPCB12

@ < Back ]l Next =

Finizh

Cancel

Fig 31. Enter project name
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¢ If you are using a Cortex-based part, the next step in the wizard will ask which
CMSIS project to use. CMSIS stands for Cortex Microcontroller Software Interface
Standard. CMSIS defines a common way to access peripheral registers and to define
interrupts. Please select the project that you imported into the workspace earlier and

click Finish.

[E=EER )

New project...

Select options for this project

Library projects

from the Examples subdirectory of your IDE installation.
CMSIS peripheral header files, initialization code and DSP library
CMSIS Library to link project to: CMSIS_CORE_LPCéxx

CMSIS DSP Library to link project to: | None

Driver Library
Library to link project to: | Mone

Select standard library projects that you want your application to link with, Any
selected library project(s) must already exist in your workspace - they can be imported

@ " CBack [ Mext> Frar

Cancel

Fig 32. CMSIS selection

Congratulations! You have created your first project!
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e L ——
Eile Edit Source Refactor Navigate Search Project Run Window Help
PN E SR R e M e @ B O D D BRI -0-a-|e
L e OO ® 5SS A L ClGE AR e Quick Access ;‘gg|
[t Project .. &2 Periphe.. Wi Registers = B @ Welcome [ main.c 2 = 8
- 3® Name : main.cf] =
(2 docs - L
11 #ifdef _ USE_CMSIS
v B inc 12 #include "LPCBioc.h”
a (B src 13 #endif
i [€] system_LPCBicc 14
history.txt 1: ::El\(iuge <&Esecti«;n_ma(m5.h)
liblinksxml 15 [Finclade <NXp/orp-hx
b = CMSIS_DSPLIE_CMO 182 // Variable to store CRP value in. Will be placed automatically
1 122 lpcB00_driver_lib 18 // by the linker when "Enable Code Read Protect” selected.
4 gMyProject 2@ // See crp.h header for mere information
b @]Include; i; __CRP const unsigned int CRP_WORD = CRP_NO _CRP ;
4B s P23 // TODO: insert other include files here ==
o [€ cr_startup_lpciix.c 24
b [€] main.c @25 // TODO: insert other definitions and declarations here b I
- 26
27= int main{void) {
DQ. B WV %B. JE0. 4fE. = O 28 B
Q. L S P29 // TODO: insert code here
38
31 // Force the counter to be placed into memory
B Start here | 32 volatile static int i = B ;
N . 33 /I Enter an infinite loop, just incrementing a counter
& New project.. Y while(1) { i
# Import project(s) 35 i+ 1l |
36
Build all projects [Debug] L 37 return 8 ; i
4, Build ‘MyProject’ [Debug] [ v
Clean 'MyProject’ [Debug] . N
s A 2 El Console 32 [Z Problems [J Memory €8 Instruction Trace Red Trace Preview #E~-r-=08
% Debug MyProject [Debug] No consoles to display at this time.
(22 Quick Settings  ~
EL Project and File wizards ¥
= T -~
NXP LPCB12 (MyProject) Writable Smart Insert 3:1
Fig 33. Project creation complete
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7. Appendix

7.1 LPCXpresso target side schematics
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Fig 35.

Schematic for the LPCXpresso LPC1769 target side (2 of 3)
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Fig 36. Schematic for the LPCXpresso LPC1769 target side (3 of 3)
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1. Design and layout compatible with LPC1343 version. Therefore, PIO2_4/5 and PIO3_4/5 swap. LPC1114 does not have USB, but LPC1343 does.
LPC1114 does not have SWO, but PIO0_9 is connected (since LPC1343 has SWO there). Recent versions of this board use a LPC1115 in place of
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Fig 38. Schematic for the LPCXpresso LPC1343 target side?

2.

This board has been replaced with the LPC1347-LPCXpresso board.
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Fig 39. Schematic for the LPCXpresso LPC11C24 target side (1 of 2)
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Fig 40. Schematic for the LPCXpresso LPC11C24 target side (2 of 2)
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7.2 LPCXpresso PCB pinout and dimensions

The schematics of the LPCXpresso Target and the LPC-LINK debug connector appear in
Fig 34 to Fig 47. The LPCXpresso board was designed to be pin compatible with NXP
mbed. LPCXpresso can be powered either through the debug mini-USB port, by 3.3 V
applied to the board, or by 5 V applied to the USB connector. A cable for the 10-pin mini
JTAG connector on the LPC-LINK debugger portion of LPCXpresso can be purchased
from Digi-Key, part number FFSD-05-D-06.00-01-N.

Dimensions: A dimensioned drawing of LPCXpresso can be found in Fig 48. The outer
dimensions of LPCXpresso are 1.35x5.45 inches. It contains two rows of holes 900 mil
apart. Each row has 27 connections and holes are drilled at a 100 mil pitch.

4 - 2 o8
1 2 JTAG TMS SWDIO y 143y
3 4 JTAG TCLK SWCLK ‘ W‘“‘] ““"“]f
5 6 JTAG TDO SWO —— Fg? ‘j
7 8 JTAG TDI | i
9 10JTAG RESET for o :“g “”“‘E I
JTAG RTCK L
J5 e N\

)

Fig 49. LPCXpresso LPC-LINK JTAG/SWO pinout
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7.3 Terminology
LPCXpresso

The Code Red Technologies IDE (Integrated Development Environment) based on
Eclipse with our own extensions for embedded development.

SWD

Serial Wire Debugging (Single Wire Debugging). This is a debug connection technology
available on the Cortex-M3 that allows debug through just 2-wires unlike 5 for JTAG.

ELF (Executable and Linking Format)

This is the object code file format used by our development tool chain and most
microprocessor tool chains.

Workspace

LPCXpresso organizes groups of projects into a ‘Workspace’. A workspace is stored as a
directory on your host PC and has subdirectories containing individual projects.

Project

An LPCXpresso project. A project contains all of the .c and .h files to build a single
microcontroller flash image.

Perspective

In LPCXpresso, a perspective is a particular collection of ‘Views'’ that are grouped
together to be suitable for a particular use. For example the ‘C/C++ programming’
perspective and the ‘Debug’ perspective.

View

A ‘View' is a window in LPCXpresso that shows a particular file or activity. A view could
be of a C source code file or something live such as a disassembly window or register
dump. A ‘Perspective’ is the layout of many ‘Views'.

Semi-hosting

The ability to use 10 on your debugger host system for your target embedded system.
For example a ‘printf’ will appear in the console window of the debugger.

Debug Target

The system being debugged. LPCXpresso includes a target microcontroller on-board, but
can also be connected to external targets.

Redlib™

The optimized Code Red Technologies C runtime library (non-GNU). LPCXpresso
includes both Redlib and Newlib libraries.
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9.1 Definitions

Draft — The document is a draft version only. The content is still under
internal review and subject to formal approval, which may result in
modifications or additions. NXP Semiconductors does not give any
representations or warranties as to the accuracy or completeness of
information included herein and shall have no liability for the consequences
of use of such information.

9.2 Disclaimers

Limited warranty and liability — Information in this document is believed to
be accurate and reliable. However, NXP Semiconductors does not give any
representations or warranties, expressed or implied, as to the accuracy or
completeness of such information and shall have no liability for the
consequences of use of such information. NXP Semiconductors takes no
responsibility for the content in this document if provided by an information
source outside of NXP Semiconductors.

In no event shall NXP Semiconductors be liable for any indirect, incidental,
punitive, special or consequential damages (including - without limitation -
lost profits, lost savings, business interruption, costs related to the removal
or replacement of any products or rework charges) whether or not such
damages are based on tort (including negligence), warranty, breach of
contract or any other legal theory.

Notwithstanding any damages that customer might incur for any reason
whatsoever, NXP Semiconductors’ aggregate and cumulative liability
towards customer for the products described herein shall be limited in
accordance with the Terms and conditions of commercial sale of NXP
Semiconductors.

Right to make changes — NXP Semiconductors reserves the right to make
changes to information published in this document, including without
limitation specifications and product descriptions, at any time and without
notice. This document supersedes and replaces all information supplied prior
to the publication hereof.

Suitability for use — NXP Semiconductors products are not designed,
authorized or warranted to be suitable for use in life support, life-critical or
safety-critical systems or equipment, nor in applications where failure or
malfunction of an NXP Semiconductors product can reasonably be expected
to result in personal injury, death or severe property or environmental
damage. NXP Semiconductors and its suppliers accept no liability for
inclusion and/or use of NXP Semiconductors products in such equipment or
applications and therefore such inclusion and/or use is at the customer’s
own risk.

Applications — Applications that are described herein for any of these
products are for illustrative purposes only. NXP Semiconductors makes no
representation or warranty that such applications will be suitable for the
specified use without further testing or modification.
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Customers are responsible for the design and operation of their applications
and products using NXP Semiconductors products, and NXP
Semiconductors accepts no liability for any assistance with applications or
customer product design. It is customer’s sole responsibility to determine
whether the NXP Semiconductors product is suitable and fit for the
customer’s applications and products planned, as well as for the planned
application and use of customer’s third party customer(s). Customers should
provide appropriate design and operating safeguards to minimize the risks
associated with their applications and products.

NXP Semiconductors does not accept any liability related to any default,
damage, costs or problem which is based on any weakness or default in the
customer’s applications or products, or the application or use by customer’s
third party customer(s). Customer is responsible for doing all necessary
testing for the customer’s applications and products using NXP
Semiconductors products in order to avoid a default of the applications and
the products or of the application or use by customer’s third party
customer(s). NXP does not accept any liability in this respect.

Export control — This document as well as the item(s) described herein
may be subject to export control regulations. Export might require a prior
authorization from competent authorities.

Evaluation products — This product is provided on an “as is” and “with all
faults” basis for evaluation purposes only. NXP Semiconductors, its affiliates
and their suppliers expressly disclaim all warranties, whether express,
implied or statutory, including but not limited to the implied warranties of non-
infringement, merchantability and fitness for a particular purpose. The entire
risk as to the quality, or arising out of the use or performance, of this product
remains with customer.

In no event shall NXP Semiconductors, its affiliates or their suppliers be
liable to customer for any special, indirect, consequential, punitive or
incidental damages (including without limitation damages for loss of
business, business interruption, loss of use, loss of data or information, and
the like) arising out the use of or inability to use the product, whether or not
based on tort (including negligence), strict liability, breach of contract, breach
of warranty or any other theory, even if advised of the possibility of such
damages.

Notwithstanding any damages that customer might incur for any reason
whatsoever (including without limitation, all damages referenced above and
all direct or general damages), the entire liability of NXP Semiconductors, its
affiliates and their suppliers and customer’s exclusive remedy for all of the
foregoing shall be limited to actual damages incurred by customer based on
reasonable reliance up to the greater of the amount actually paid by
customer for the product or five dollars (US$5.00). The foregoing limitations,
exclusions and disclaimers shall apply to the maximum extent permitted by
applicable law, even if any remedy fails of its essential purpose.

9.3 Trademarks

Notice: All referenced brands, product names, service names and
trademarks are property of their respective owners.
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